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Excel delete rows with specific text

Thank you for visiting. My goal is to make you awesome in Excel and Power BI. I do this by sharing videos, tips, examples and downloads on this site. There are more than 1,000 pages with all things Excel, Power BI, Dashboard and VBA here. Go ahead and spend a few minutes to be awesome. Read my story suggestions A ¢ A ¢ FREE Excel book in
this tutorial we are going to look at how to delete rows or columns, or have a certain criteria or that are empty. You can download the file here and follow along. When you get a preview, look for the Download button in the upper right corner. So here I have a set of data in column A, and there are the names of various people. Note that the name
"Tom" appears six times and I want to delete all the lines that "Tom" in that column: I highlight the data in column "A", then use the shortcut Ctrl + F shortcut to open the Find & replace dialog box and enter "Tom" in the search box, then click Find all: This will generate a list of hyperlinks that point to every cell that contains "Tom". With the top of
the already mentioned, I'll keep my Shift key and click on the bottom to select all. Note that will bring out all the cells of my data set containing "Tom": I can now close the Find and Replace dialog box, and those cells are still selected. Then, I use the keyboard shortcut Ctrl + A (the Control key plus the minus key), and will open the Delete dialog.
SceglierA? "The whole row": It | and when I click on OK, all the rows that contain "Tom" were deleted: If the data has been transposed and the names were at the top, you can use the same process, but choose "All" column instead . Watch the video to see how it's done. For the elimination of empty spaces, the process is slightly different. Here I data
with blank lines scattered throughout: to remove blank lines, I first highlight any column that contains blank spaces (in this case, any one will do), then press the F5 key, which brings up the dialog box Jump to: CAN I then click on "special" or use the keyboard shortcut Alt + S. This will bring me to the Go to special dialog box. Here you can select
"empty spaces" or use the keyboard shortcut Alt + K: When I click OK, will select those cells that are blank: Then, as before, I can use the keyboard shortcut Ctrl + A and choose whole row, and the rows will be deleted. To delete the columns that have empty spaces is the same process, but the choice of the whole column. Again, check out the video
for more details. What can you do next? Share this post with others who can benefit from it! Leave a comment or reply below A ¢ — "let me know what you think! Subscribe to this blog for more tips in the future, or ... Take a look at my YouTube channel! Hello Excellers, time for some macro Excel again fun. today's tip Excel Macro is one I looked
forward to sharing with you for a while 'a How to eliminate all row in the Excel spreadsheet containing specific text string.This is a question I do fairly regularly, and it is a very useful piece of code to know. the most common way to address this is to scroll through the entire column, and if a cell in the column contains the specified text string and then
to delete the entire line. since Excel will shift upward the default rows of deletion, then the most logical way to do this is to start from the bottom and loop upwards.This work is quite a slow process and works for data sets smaller because it is time-consuming and slow in the ese execution, but not Well on the larger data set, even with the Application
Objects Properties ScreenUpdating and Manual Calculation for the following reasons: - The Delete Row Trigger Excel command to recalculate, which if there are a lot of formulas in the worksheet is requires weather. By scrolling all the cells in a column or even the cells used in a column is also time. Thus Let S hiring we have the larger data set, and
we want to perform this procedure more efficiently. Well, I chose use usage Autofilter method, which assesumes our data set is set in a certain way, with the first line containing field headers or column names. (May mine!). Download macro Monday example files. What does the Macro do? This macro identify and filter all the lines that contain the text
string your specification, then delete them. How does it work? FIRST. Opening a Visual Basic Pressing ALT + F11 or Insert Developer Tab a Visual Basic A menu A ¢ moduleStep 1. You specify that we are using Active WorksKeet, in order to ensure no other worksheet is influenced by our actions, and at this stage The car filter is first deactivated (if
via) Excel.Step 2. The filter is applied to our data range that is set to column A, up to the last line with Data.Step 3. Now they are filtered up All lines that contain a totala, in column A, (or column 1) Phase 4. All lines, now that they are visible in filtered data are deleted, using specialcells (12) .ENTIREROW. Delete but we specified that we are
compensating for cancellation from 1 mobile phone, this is to welcome the field headers or column that we do not want Delete.Step 5. Finally the autofiter is removed once again.Step 6. Test your macro Him! Him! Sub DeleteRewsMeetingCryriteria () with ActiveSheet .AutofilterMode = false with range (A ¢ ala, range (aa & rows.count) .end (XLUP))
Autofilter 1, to Totala on error Resume Next .offset (1) .specialcells ( 12) .Arerow.Delete End with .AutofilterMode = False End With End Sub Microsoft Excel 2010 comes with the latest version of Visual Basic, Applications, or VBA, which is a programming language designed to easily interface with products Microsoft Office. VBA allows you to
automate repetitive operations, for example, passing through a long worksheet and lines automatically eliminating that contain the specified text. Once you set your VBA code correctly, all you have to do is press a button and all targeted lines will be deleted. When working with large amounts of data in spreadsheets, you need all the advice and
suggestions that can be obtained to quickly access the requested data. Often you may need to work with the rows selected in bulk. For example, you may need to delete the rows that contain a specific text, or maybe format them a certain way. In all these cases, if you work with them in a single movement, you must first select these rows at the same
time. Unfortunately, the rows by selecting them with a specific text in Excel can be quite a complicated business. In this tutorial we will show you two ways you can select the rows with a specific text in Excel: using VBAUSING data filters The first method is simple and fast, but involves a bit of encoding. If youA ¢ King is not comfortable with the
encoding, you can opt for the second method. To demonstrate the two methods in this tutorial, we are going to use the following data: view the above data, let's say you want to find and select all the rows that contain the word A ¢ king ¢ in them. Here are two ways to deal with this problem. Using VBA to select rows with specific text in Excel this
method involves VBA encoding. We have already prepared the code that you need to use, so all you have to do is just browse the Developer window, copy and paste the code, select the data you want to work and run the code. To use this code, you must first select the data you want to select rows with specific text and then run this code. The following
code will help you select the rows with a specific text in Excel. 'This code was developed by Steve SpreadsheetPlanet.com Sub Select Rows With GIVEN STRING () DIM RNG as a DIM MYCELL GAMMA as an object DIM MyUnion as a RNG SET RANGE = SEARCHSTRING SELECTION = INPUTBOX ("Insert the String Search") for each MYCELL IN
RNG SE INSTR (MYCELL.TEXT, SEARCHSTRING) then if if Not MyUnion is nothing then set myunion = union (myunion, mycell.entirerow) else set myunion = mycell.entirow end IF end if next if myUnion is nothing then msgbox "the text has not been found in the selection" MyUnion. Select Else Else If you end up the aforementioned macro loops
over each cell in an interval and select only the rows that contain the text A ¢ 4,— A "kingA ¢ 4,—. Note that the code above is sensitive to homes. In case you are looking for the word A ¢ 4,— A "kingA ¢ 4,— 4" & "¢, you will not be able to find it and show you a box of messages that allows you to know that you could not find the specified text. To enter
the code above, copy it and paste it into the developer window. Here's how to copy and run this code: From the Developer tab, select Visual Basic. Once the VBA window is opened, you will see all the files and folders in the Explorer project on the left side. If you don't see the Explorer project, click View-> Explorer Project. Make sure it A ¢ 4,— A
"ShisworkBookA ¢ &,— &" ¢ is selected under the VBA project with the same name as your Excel.Click job folder Insert-> Module. A new module window should be open. Now you can start encoding. Copy the code script above and glue to the module code window. Your macro is now ready for use. Note: If you do not see the developer tape, from the
File menu, go to the options. Select Customize the tape and controls the Developer option from the main tabs. Finally, click OK. Now that we copied the code in the right place, we have to run the code. To run your macro, do the following: Select the range of cells you want to work with. Select the Developer tab. Click the Macro button (under the code
group). This will open the Macro window, where you will find the names of all the macros you have created so far. Select the macro (or module) called A ¢ &4,— & "select rows_with _given stringA ¢ &4,— &" ¢. Click. Run Run. You will get an input box that you will ask you to enter your search string. Type the text you want to search. In our example, we
are trying to select all the rows with the word A ¢ 4,— A "kingA ¢ 4,— &" ¢ in it. So let's type A ¢ 4,— A "kingA ¢ 4,— &" ¢. For ok. All lines containing your search string now should be selected. Now that your required lines are selected, you can go ahead and perform all the actions needed with them. You can also use this script and edit it to meet your
needs. Explanation of the code so how does this code work? A, in the code above we used the INPUTBOX function to get the user search string input. We therefore used a cycle for each to scroll each cell in the specified range (RNG). If a cell contains the date search string, we add the entire line of that cell to MyUnion (an interval variable containing
the range of all the rows we want to select). To find out if a cell contains the date search string, we used the Instr function. In the end we used the command A ¢ 4,— ~ myunion.selectA ¢ 4,— & "¢ to select all the rows that have been added to MyUnion. In this way, the code selects all lines that contain the user search string. Using filters To select rows
with specific text in Excel The VBA method is actually the best way to select lines with specific text in Excel. However, if the idea of encoding or using VBA intimidates you, then there is an alternative way to get the job. This involves the use of functionality of Excel filters. This function allows you to filter the rows that correspond to a given criterion.
So you can easily use it to see which lines contain your specified text. You will filter all the other lines and show you only the corresponding ones. So, get all your lines required one under another. This makes you easy to select all the filtered rows at a point of view and perform subsequent actions on them. Here are the steps you need to follow if you
Use filters to select lines with specific text: Click on the header of any column in the range you want to work on.Click on the data tab and select the Filter button (you & "¢ &" ¢ I will find it under the group A ¢ 4,— A «rare and filter". You should now see a small arrow button on each header line cell. These buttons are intended to help you filter your
cells. You can click on any arrow to choose a filter for The corresponding column. In this example, we want to look for titles in the column A ¢ &4,— A "Books". Then click on the arrow next to the heading. This will show a let down with several filtering options. In the input box below = A ¢ A "A ¢ &,—4 FiltriText FiltersA ¢, type your search string. Since
we are looking for the word A ¢ 4,—A Kinga ¢ & ¢ 4,—4, we will write in the input box. Click OK. You should now be able to see only those lines that contain the word A ¢ 4,—A Kinga ¢ & ¢ &4,—4 in the books column. Now you can select all the rows displayed row headers altogether. This will make that only the visible rows are selected. Hidden lines
(which do not contain the word A ¢ 4,—A Kinga ¢ & ¢ 4,—4) will not be selected. Now that your required rows are selected, you can go ahead and copy, delete or perform any activities necessary with them. One thing I like about this method is that it allows you to apply more states at the same time and then allow you to select the records. For example,
if I want to select all the rows where the name of the book has the word A ¢ 4,—A Kinga ¢ & ¢ 4,—4a and the state of availability of the book is yes, then I can do it. All I have to do is apply two separate filters and then select the lines that remain. In this tutorial we showed you two tricks to select rows with specific text in Excel. I hope this has been
helpful and easy to apply. Some other Excel tutorial you will also like: like:
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